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CCPPUU
CPU stands for Central Processing Unit and is the intelligence of the computer. All
the processing occurs in the CPU. Silicon chips, which contain miniaturized circuitry,
are placed on boards that are plugged into slots within the CPU. Whenever an
instruction is given to the computer, that instruction is processed through circuitry in
the CPU.

In this textbook, you will learn to operate one or more microcomputer application
programs that combine to make an application “suite.” This suite of programs is
called Microsoft Office Professional 2000. Before you begin, you should familiarize
yourself with the basics of computers, including hardware, software, the keyboard, the
mouse, and Office Assistant (a help program).

IIddeennttiiffyyiinngg CCoommppuutteerr HHaarrddwwaarree
The computer equipment you will use to operate the suite of programs is referred to
as hardware. You will need access to an IBM PC or an IBM-compatible computer. This
computer system should consist of the CPU, monitor, keyboard, printer, disk drive,
and mouse. If you are not sure what equipment you will be operating, check with
your instructor. The computer system displayed in figure G.1 consists of six
components. Each component is discussed separately in the material that follows.

GGeettttiinngg SSttaarrtteeddGGeettttiinngg SSttaarrtteedd
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Monitor
The monitor is a piece of equipment that looks like a television screen. It displays
the information of a program and the text being input at the keyboard. The
quality of display for monitors varies depending on the type of monitor and the
type of resolution. Monitors can also vary in size—generally from 14-inch size up
to 21-inch size.

Keyboard
The keyboard is used to input information into the computer. Keyboards for
microcomputers vary in the number and location of the keys. Microcomputers
have the alphabetic and numeric keys in the same location as the keys on a
typewriter. The symbol keys, however, may be placed in a variety of locations,
depending on the manufacturer. In addition to letters, numbers, and symbols,
most microcomputer keyboards contain function keys, arrow keys, and a numeric
keypad. Figure G.2 shows an enhanced keyboard.

Microcomputer Enhanced Keyboard
G.2

The 12 keys at the top of the enhanced keyboard, labeled with the letter F
followed by a number, are called function keys. These keys can be used to perform
functions within each of the suite programs.

To the right of the regular keys is a group of special or dedicated keys. These keys
are labeled with specific functions that will be performed when you press the key.
Below the special keys are arrow keys. These keys are used to move the insertion
point in the document screen. 

In the upper right corner of the keyboard are three mode indicator lights.
When certain modes have been selected, a light appears on the keyboard. For
example, if you press the Caps Lock key, which disables the lowercase alphabet, a
light appears next to Caps Lock. Similarly, pressing the Num Lock key will disable
the special functions on the numeric keypad, which is located at the right side of
the keyboard.

Disk Drive
Depending on the computer system you are using, Microsoft Office Professional is
installed on a hard drive or as part of a network system. Whether you are using
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the suite on a hard drive or network system, you will need to have a disk drive
available for inserting a 3.5-inch disk, on which you will save and open
documents.

The memory capacity for disks varies depending on the density of the disk.
Disk memory is measured in kilobytes (thousands) and megabytes (millions). The
memory capacity for a 3.5-inch double density (DD) disk is 720,000 bytes (720 
kilobytes, which is written as 720Kb). The memory capacity for a 3.5-inch high
density disk (HD) is 1,440,000 bytes (1.44 megabytes, which is written as 1.44Mb).

Printer
When you create a document in one of the suite programs, it is considered soft
copy. If you want a hard copy of a document, you need to print it. To print
documents you will need to access a printer. Printers are either impact or
nonimpact. Impact printers have a mechanism that strikes the paper to create text.
Nonimpact printers use a variety of methods—heat, ink jet, laser—to print
characters. These printers are much quieter and faster than impact printers.

Mouse
Many functions in the suite programs are designed to operate more efficiently
with a mouse. A mouse is an input device that sits on a flat surface next to the
computer. A mouse can be operated with the left or the right hand. Moving the
mouse on the flat surface causes a corresponding mouse pointer to move on the
screen. Figure G.1 shows an illustration of a mouse. For specific instructions on
how to use a mouse, please refer to the “Using the Mouse” text later in this
section.

MMaaiinnttaaiinniinngg DDiisskkss
You will be copying chapter folders onto a 3.5-inch disk and then saving and
opening files from this disk. To ensure that you will be able to retrieve
information from the disk, you need to follow certain rules of disk maintenance.
To properly maintain a 3.5-inch disk, follow these rules:
• Do not expose the disk to extreme heat or cold.
• Keep the disk away from magnets and magnetic fields. They can erase the

information saved on the disk.
• Do not wipe or clean the magnetic surface of the disk.
• Keep the disk away from food, liquids, and smoke.
• Never remove the disk from the disk drive when the drive light is on.
• Carry the disk in a plastic case to prevent damage to the metal shutter.

The 3.5-inch disk on which you will open and save files must be formatted.
Most likely, any disk you purchase will already be formatted. Formatting is a
process that establishes tracks and sectors on which information is stored and
prepares the disk to accept data from the disk operating system (and erases
anything previously saved on the disk). If you are using a disk that is not
formatted, check with your instructor on the steps needed to format. (You can
also look up the steps to format using the Windows Help feature. The Windows
Help feature is presented later in this section.)
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UUssiinngg tthhee MMoouussee
The programs in the Microsoft Office Professional suite can be operated using a
keyboard or they can be operated with the keyboard and a mouse. The mouse
may have two or three buttons on top, which are tapped to execute specific
functions and commands. To use the mouse, rest it on a flat surface or a mouse
pad. Put your hand over it with your palm resting on top of the mouse and your
wrist resting on the table surface. As you move the mouse on the flat surface, a
corresponding pointer moves on the screen.

When using the mouse, there are four terms you should understand—point,
click, double-click, and drag. When operating the mouse, you may need to point
to a specific command, button, or icon. Point means to position the mouse
pointer on the desired item. With the mouse pointer positioned on the desired
item, you may need to click a button on the mouse. Click means quickly tapping a
button on the mouse once. To complete two steps at one time, such as choosing
and then executing a function, double-click a mouse button. Double-click means to
tap the left mouse button twice in quick succession. The term drag means to press
and hold the left mouse button, move the mouse pointer to a specific location,
and then release the button.

Using the Mouse Pointer
The mouse pointer will change appearance depending on the function being
performed or where the pointer is positioned. The mouse pointer may appear as
one of the following images:

The mouse pointer appears as an I-beam (called the I-beam pointer) in the
document screen and can be used to move the insertion point or select text.

The mouse pointer appears as an arrow pointing up and to the left (called the
arrow pointer) when it is moved to the Title bar, Menu bar, or one of the toolbars
at the top of the screen or when a dialog box is displayed. For example, to open a
new document with the mouse, you would move the I-beam pointer to the File
option on the Menu bar. When the I-beam pointer is moved to the Menu bar, it
turns into an arrow pointer. To make a selection, position the tip of the arrow
pointer on the File option, and then click the left mouse button. At the drop-
down menu that displays, make selections by positioning the arrow pointer on the
desired option, and then clicking the left mouse button.

The mouse pointer becomes a double-headed arrow (either pointing left and
right, pointing up and down, or pointing diagonally) when performing certain
functions such as changing the size of a picture.
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In certain situations, such as moving a picture or frame, the mouse pointer
becomes a four-headed arrow. The four-headed arrow means that you can move
the object left, right, up, or down.

When a request is being processed or when a program is being loaded, the
mouse pointer may appear with an hourglass beside it. The hourglass image
means “please wait.” When the process is completed, the hourglass image is
removed.

The mouse pointer displays as a hand with a pointing index finger in certain
functions such as Help and indicates that there is more information available
about the item.

CChhoooossiinngg CCoommmmaannddss
Once a program is open, several methods can be used in the program to choose
commands. A command is an instruction that tells the program to do something.
You can choose a command with one of the following methods:
• Click a toolbar button with the mouse.
• Choose a command from a menu.
• Use shortcut keys.
• Use a shortcut menu.

Choosing Commands on Toolbars
When a program such as Word or PowerPoint is open, several toolbars containing
buttons for common tasks are available. In many of the suite programs, two
toolbars are visible on the screen (unless your system has been customized). One
toolbar is called the Standard toolbar; the other is referred to as the Formatting
toolbar. To choose a command from a toolbar, position the tip of the arrow
pointer on a button, and then click the left mouse button. For example, to print
the document currently displayed in the document screen, position the tip of the
arrow pointer on the Print button on the Standard toolbar, and then click the left
mouse button.

Choosing Commands on the Menu Bar
Each of the suite applications contains a Menu bar that displays toward the top
of the screen. This Menu bar contains a variety of options you can use to perform
functions and commands on data. Functions are grouped logically into options,
which display on the Menu bar. For example, features to work with files
(documents) are grouped in the File option. Either the mouse or the keyboard
can be used to make choices from the Menu bar or make a choice at a dialog box.
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To use the mouse to make a choice from the Menu bar, move the I-beam
pointer to the Menu bar. This causes the I-beam pointer to display as an arrow
pointer. Position the tip of the arrow pointer on the desired option, and then click
the left mouse button.

To use the keyboard, press the Alt key to make the Menu bar active. Options
on the Menu bar display with an underline below one of the letters. To choose an
option from the Menu bar, key the underlined letter of the desired option, or
move the insertion point with the left or right arrow keys to the option desired,
and then press Enter. This causes a drop-down menu to display.

For example, to display the File drop-down menu in Word as shown in figure
G.3 using the mouse, position the arrow pointer on File on the Menu bar, and
then click the left mouse button. To display the File drop-down menu with the
keyboard, press the Alt key, and then key the letter F for File.

G.3
Word File Drop-Down Menu

Choosing Commands from Drop-Down Menus
To choose a command from a drop-down menu with the mouse, position the
arrow pointer on the desired option, and then click the left mouse button. At the
drop-down menu that displays, drag the arrow pointer down the menu to the
desired option, and then click the left mouse button.

To make a selection from the drop-down menu with the keyboard, key the
underlined letter of the desired option. Once the drop-down menu displays, you
do not need to hold down the Alt key with the underlined letter. If you want to
close a drop-down menu without making a choice, click in the document screen
outside the drop-down menu; or, press the Esc key twice.

If an option can be accessed by clicking a button on a toolbar, the button is
displayed preceding the option in the drop-down menu. For example, buttons
display before the New, Open, Save, and Print options at the File drop-down
menu (see figure G.3).

Some menu options may be gray shaded (dimmed). When an option is
dimmed, that option is currently not available. For example, if you choose the
Table option on the Menu bar, the Table drop-down menu displays with dimmed
options including Merge Cells and Table AutoFormat.
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Some menu options are preceded by a check mark. The check mark indicates
that the option is currently active. To make an option inactive (turn it off) using
the mouse, position the arrow pointer on the option, and then click the left mouse
button. To make an option inactive (turn it off) with the keyboard, key the
underlined letter of the option.

If an option from a drop-down menu displays followed by an ellipsis (...), a
dialog box will display when that option is chosen. A dialog box provides a
variety of options to let you specify how a command is to be carried out. For
example, if you choose File and then Print from the PowerPoint Menu bar, the
Print dialog box shown in figure G.4 displays.

G.4
PowerPoint Print Dialog Box

Or, if you choose Format and then Font from the Word Menu bar, the Font
dialog box shown in figure G.5 displays.

G.5
Word Font Dialog Box
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Some dialog boxes provide a set of options. These options are contained on
separate tabs. For example, the Font dialog box shown in figure G.5 contains a tab
at the top of the dialog box with the word Font on it. Two other tabs display to
the right of the Font tab. The tab that displays in the front is the active tab. To
make a tab active using the mouse, position the arrow pointer on the desired tab,
and then click the left mouse button. If you are using the keyboard, press Ctrl +
Tab or press Alt + the underlined letter on the desired tab. For example, to
change the tab to Character Spacing in the Font dialog box, click Character
Spacing, or press Ctrl + Tab, or press Alt + R.

To choose options from a dialog box with the mouse, position the arrow
pointer on the desired option, and then click the left mouse button. If you are
using the keyboard, press the Tab key to move the insertion point forward from
option to option. Press Shift + Tab to move the insertion point backward from
option to option. You can also hold down the Alt key then press the underlined
letter of the desired option. When an option is selected, it displays either in
reverse video (white letters on a blue background) or surrounded by a dashed box
called a marquee.

A dialog box contains one or more of the following elements: text boxes, list
boxes, check boxes, option buttons, spin boxes, and command buttons.

Text Boxes
Some options in a dialog box require text to be entered. For example, the boxes
below the Find what and Replace with options at the Excel Replace dialog box
shown in figure G.6 are text boxes. In a text box, you key text or edit existing text.
Edit text in a text box in the same manner as normal text. Use the left and right
arrow keys on the keyboard to move the insertion point without deleting text and
use the Delete key or Backspace key to delete text.

G.6
Excel Replace Dialog Box

List Boxes
Some dialog boxes such as the Access Open dialog box shown in figure G.7 may
contain a list box. The list of files below the Look in: option is contained in a list
box. To make a selection from a list box with the mouse, move the arrow pointer
to the desired option, and then click the left mouse button.

Text Boxes
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Some list boxes may contain a scroll bar. This scroll bar will display at the
right side of the list box (a vertical scroll bar) or at the bottom of the list box (a
horizontal scroll bar). Either a vertical scroll bar or a horizontal scroll bar can be
used to move through the list if the list is longer than the box. To move down
through a list on a vertical scroll bar, position the arrow pointer on the down
scroll triangle and hold down the left mouse button. To scroll up through the list
in a vertical scroll bar, position the arrow pointer on the up scroll triangle and
hold down the left mouse button. You can also move the arrow pointer above the
scroll box and click the left mouse button to scroll up the list or move the arrow
pointer below the scroll box and click the left mouse button to move down the
list. To move through a list with a horizontal scroll bar, click the left scroll triangle
to scroll to the left of the list or click the right scroll triangle to scroll to the right
of the list.

To make a selection from a list using the keyboard, move the insertion point
into the box by holding down the Alt key and pressing the underlined letter of
the desired option. Press the up and/or down arrow keys on the keyboard to move
through the list.

In some dialog boxes where there is not enough room for a list box, lists of
options are inserted in a drop-down list box. Options that contain a drop-down
list box display with a down-pointing triangle. For example, the Underline style
option at the Word Font dialog box (refer to figure G.5) contains a drop-down
list. To display the list, click the down-pointing triangle to the right of the
Underline style text box. If you are using the keyboard, press Alt + U.

Check Boxes
Some dialog boxes contain options preceded by a box. A check mark may or may
not appear in the box. The Word Font dialog box (refer to figure G.5) displays a
variety of check boxes within the Effects section. If a check mark appears in the
box, the option is active (turned on). If there is no check mark in the check box,
the option is inactive (turned off).

G.7
Access Open Dialog Box
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Any number of check boxes can be active. For example, in the Word Font
dialog box, you can insert a check mark in any or all of the boxes in the Effects
section and these options will be active.

To make a check box active or inactive with the mouse, position the tip of the
arrow pointer in the check box, and then click the left mouse button. If you are
using the keyboard, press Alt + the underlined letter of the desired option.

Option Buttons
In the PowerPoint Print dialog box (refer to figure G.4), the options in the Print
range section are preceded by option buttons. Only one option button can be
selected at any time. When an option button is selected, a dark circle displays in
the button.

To select an option button with the mouse, position the tip of the arrow
pointer inside the option button, and then click the left mouse button. To make a
selection with the keyboard, hold down the Alt key, and then press the underlined
letter of the desired option. 

Spin Boxes
Some options in a dialog box contain measurements or numbers that can be
increased or decreased. These options are generally located in a spin box. For 
example, the Word Paragraph dialog box shown in figure G.8 contains a variety of
spin boxes located after the Left, Right, Before, and After options. To increase a
number in a spin box, position the tip of the arrow pointer on the up-pointing
triangle to the right of the desired option, and then click the left mouse button. To
decrease the number, click the down-pointing triangle. If you are using the
keyboard, press Alt + the underlined letter of the desired option, and then press the
up arrow key to increase the number or the down arrow key to decrease the number.

G.8
Word Paragraph Dialog Box
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Command Buttons
In the Excel Replace dialog box (refer to figure G.6), the boxes at the right side of
the dialog box are called command buttons. A command button is used to execute
or cancel a command. Some command buttons display with an ellipsis (...). A
command button that displays with an ellipsis will open another dialog box. To
choose a command button with the mouse, position the arrow pointer on the
desired button, and then click the left mouse button. To choose a command
button with the keyboard, press the Tab key until the desired command button
contains the marquee, and then press the Enter key.

Choosing Commands with Shortcut Keys
At the left side of a drop-down menu is a list of options. At the right side,
shortcut keys for specific options may display. For example, the shortcut keys to
save a document are Ctrl + S and are displayed to the right of the Save option at
the File drop-down menu (refer to figure G.3). To use shortcut keys to choose a
command, hold down the Ctrl key, key the letter for the command, and then
release the Ctrl key. 

Choosing Commands with Shortcut Menus
The software applications in the suite include menus that contain commands
related to the item with which you are working. A shortcut menu appears right
where you are working in the document. To display a shortcut menu, click the
right mouse button or press Shift + F10.

For example, if the insertion point is positioned in a paragraph of text in a
Word document, clicking the right mouse button or pressing Shift + F10 will
cause the shortcut menu shown in figure G.9 to display in the document screen.

To select an option from a shortcut menu with the mouse, click the desired
option. If you are using the keyboard, press the up or down arrow key until the
desired option is selected, and then press the Enter key. To close a shortcut menu
without choosing an option, click anywhere outside the shortcut menu or press
the Esc key.

G.9
Word Shortcut Menu

Shortcut
Menu
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UUssiinngg tthhee MMiiccrroossoofftt OOffffiiccee AAssssiissttaanntt
Microsoft Office Professional 2000 includes an Office Assistant. This Assistant is a
link to the on-screen Help feature that anticipates the type of help you need and
suggests Help topics related to the work you are doing. The Assistant will also
point out ways to perform tasks more easily and provide visual examples and step-
by-step instructions for specific tasks. When you open a program, the Assistant
displays, by default, in the lower right corner of the screen as shown in figure
G.10. The default Assistant is named “Clippit,” and is an image of a paper clip.
(This image can be changed.) 

The Assistant will perform a variety of functions. For example, if you try to
close a document without saving it, the Assistant will make a sound to get your
attention and display a question box like the one shown in figure G.11. At this
question, click the desired response.

G.10
Office Assistant

Office
Assistant
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G.11
Assistant Question Box

G.12
Office Assistant Help Topics List

If you are completing a task that one of the Office programs will automatically
format, the Assistant will specify what the particular program is doing. For example,
if you key a numbered paragraph in Word, Word will automatically format this
numbered paragraph. As you are keying the numbered paragraph, the Assistant will
tell you that Word is automatically formatting the text and ask if you want to learn
more about the feature.

If you are working on a task and want help, just click the Assistant. The
Assistant will guess what kind of help you want and display a list of Help topics
like the list shown in figure G.12. If the desired topic does not display, key a
question in the text box that displays below the list of topics, and then click the
Search button.

Office Assistant
Question Box

Help Topics
List Box
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Occasionally, a light bulb will display above the Assistant. Click this light bulb
and the Assistant will display a tip about the type of work you are doing.

Hiding/Turning Off the Office Assistant
To hide the Office Assistant, click Help and then Hide the Office Assistant.
Redisplay the Office Assistant by clicking Help and then Show the Office
Assistant. The Office Assistant can also be turned off for the entire Word session.
To do this, click the Office Assistant and then click the Options button that
displays in the yellow box. At the Office Assistant dialog box that displays, click
the Use the Office Assistant option to remove the check mark, and then click OK.

Changing the Assistant
Microsoft Office Professional offers a variety of other Office Assistants. To display
and choose another Assistant, position the arrow pointer on the Assistant, and
then click the right mouse button. At the shortcut menu that displays, click
Choose Assistant. This displays the Office Assistant dialog box shown in figure
G.13. At this dialog box, the current Assistant displays. To display other
Assistants, click the Next button. You can choose from The Dot, F1, The Genius,
Office Logo, Mother Nature, Links, and Rocky.

G.13
Office Assistant Dialog Box

You can customize the Office Assistant by clicking the Options tab at the
Office Assistant dialog box. This displays a dialog box with a variety of Help
options. Insert a check mark before the features you want active and remove the
check mark for those features you want inactive.

WWoorrkkiinngg wwiitthh MMuullttiippllee PPrrooggrraammss
As you learn the various applications in the Microsoft Office Professional suite,
you will notice how executing commands in each is very similar. For example, the
steps to save, close, and print are virtually the same whether you are working in
Word, Excel, PowerPoint, or Access. This consistency among programs greatly
enhances a user’s ability to easily transfer knowledge learned in one program to
another within the suite.

Another appeal of Microsoft Office Professional is the ability to have more
than one program open at the same time. For example, you can open Word, create
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a document, and then open Excel, create a spreadsheet, and copy the spreadsheet
into Word. 

When a program is open, the name of the program followed by a document
name displays in a button on the Taskbar. When another program is opened, the
name of the program displays in a button that is positioned to the right of the
first program button. Figure G.14 shows the Taskbar with Word, Excel, and
PowerPoint open. To move from one program to another, all you need to do is
click the button on the Taskbar representing the desired program.

As you learn the applications in the Microsoft Office Professional suite, you
will learn more about the features presented in this section.

IInnssttaalllliinngg AAddddiittiioonnaall FFeeaattuurreess
During a standard installation of Microsoft Office Professional, all features and
applications may not be installed. To install additional features or applications,
you would complete the following basic steps (you may want to refer to the
Microsoft Office documentation for specific information):

1. At the Windows desktop, double-click the My Computer icon.
2. At the My Computer window, double-click the Control Panel icon.
3. At the Control Panel window, double-click the Add/Remove Program

icon.
4. At the Add/Remove Programs Properties dialog box, click Install.
5. At the next screen, insert the Microsoft Office setup CD in the

appropriate drive. Follow the steps provided by the Install Wizard to
install additional features or applications.

CCoommpplleettiinngg CCoommppuutteerr EExxeerrcciisseess
Some computer exercises in this textbook require that you open an existing file.
Exercise files are saved on the CD that accompanies this textbook. The files you
need for each chapter are saved in individual folders. Before beginning a chapter,
copy the necessary folder from the CD to a preformatted data disk. After
completing the exercises in a chapter, delete the chapter folder before copying the
next chapter folder. (Check with your instructor before deleting a folder.)

Copying a Folder
The CD that accompanies this textbook contains numerous files you use to
complete some exercises and assessments in chapters. As you begin working in a
chapter, copy the chapter folder from the CD to your disk. (Not every chapter
contains a folder on the CD. For example, when completing exercises in the
Access chapters, you will copy database files from the CD rather than individual
chapter folders. This is to ensure that there is adequate space on your disk for

G.14 Taskbar with Word, Excel, and PowerPoint Open
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saving files.) Copy the chapter folder from the CD to your disk using Windows
Explorer by completing the following steps:

1. Insert the CD that accompanies this textbook in the CD-ROM drive.
2. Insert a formatted 3fi-inch disk in the 

disk drive.
3. At the Windows desktop, click the Start

button on the Taskbar, point to Programs,
and then click Windows Explorer.

4. In Windows Explorer, click the down-
pointing triangle at the right side of the
Address list box.

5. At the drop-down list
that displays, click
the drive where the
CD is located.

6. In the list box, click
the chapter folder
you want to copy.

7. Click the Copy
button on the
Windows Explorer toolbar.

8. Click the down-pointing triangle at
the right side of the Address list
box and then click the drive
where your disk is located.

9. Click the Paste button on the
Windows Explorer toolbar.

10. After the folder is copied to your
disk, close Windows Explorer by
clicking the Close button located
in the upper right corner of Windows Explorer.

Deleting a Folder
Before copying a chapter folder onto your disk, delete any previous chapter folders.
Do this in Windows Explorer by completing the following steps:

1. Insert your disk in the disk drive.
2. At the Windows desktop, click the Start button on the Taskbar, point to

Programs, and then click Windows Explorer.
3. In Windows Explorer, click the down-pointing triangle at the right side of

the Address list box.
4. At the drop-down list that displays, click the drive where your

disk is located.
5. Click the chapter folder in the

list box.
6. Click the Delete button on the

Windows Explorer toolbar.
7. At the message asking if you want to remove the folder and all its

contents, click the Yes button.
8. At the message asking if you want to delete a read-only file, click the yes to

All button.
9. Close Windows Explorer by clicking the Close button located in the upper

right corner of Windows Explorer.
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